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Working in the Node Editor

This chapter covers advanced node structures you can create in DaVinci Resolve, showing you
how to combine Color page effects in even more detailed ways to control your order of
operations, combine multiple nodes, use HDR inputs, composite, and create compositing

effects all inside of Resolve.

This chapter has the following topics:

The Node Editor Interface

The Components of a Node Tree

Node Badges and Labels

Selecting Nodes

Disabling Nodes

Bypass All Grades

Resetting Nodes

Previewing and Restoring Node Trees

Caching Specific Nodes to Improve Performance
Editing Node Trees

Copying Nodes From Other Clips
Copying Node Settings

Serial Node Structures
Parallel Node Structures
Layer Mixer Node Structures
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External Mattes to Limit Adjustments

Extracting External Mattes from OpenEXR Layers
Using External Mattes to Add Texture

Using External Mattes to Create Transparency
Key Palette Controls for the External Matte Node

Adding Two Keys Together
Subtracting One Key from Another
Adding Inputs to Key Mixer Nodes

Using the Key Palette to Affect Corrector Nodes
Using the Key Palette to Adjust Key Mixer Controls
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Node Editor Basics

By default, every clip has one node in the Node Editor that contains the first corrections you
make. However, you also have the option of creating multiple nodes, where each node contains
one or more corrections that affect the image.

The Node Editor showing a reasonably full-featured grade

The specific arrangement of nodes you create lets you exert precise control over the order of
operations performed by your grade, which provides many advantages. This section covers
different ways of creating, editing, and arranging node trees to harness the full power of
DaVinci Resolve.

How Many Nodes Do | Need to Use?

In this chapter, you'll learn many, many different techniques for combining adjustments
and nodes in different ways to achieve highly specific effects. Consequently, new
Resolve users often wonder, how far do | go? There is no right answer, but suffice it to
say that some of the world’s leading colorists achieve stunning results in as few as three
or four nodes, while others routinely build carefully organized hierarchies of ten to
twenty nodes, or more. The number of nodes you use is often dependent on the quality
of media you've been given to work with, as well-lit footage usually requires less work
than material shot run-and-gun with available light, that typically needs many more
adjustments to achieve an acceptable result. Furthermore, the number of nodes you
may use can also depend on what kind of program you’re working on, with commercial
spots affording the colorist enough time in the schedule to build truly massive grades
that adjust every little detail, and narrative features and television shows requiring you
to work faster and do more within fewer adjustments in order to stay on track. The real
answer? Each grade requires as many nodes as are necessary. No more, no less.
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As you work within the Node Editor, you may find the need to zoom into or out of it to get a
better look at the node tree, and to pan around the working area to deal with large
collections of nodes.

To expand the size of the Node Editor’s working area:

= Drag the border between the Node Editor and the Gallery to the left or right to make it
wider or narrower.

= Right-click anywhere within the Node Editor (except on a node) and choose Toggle
Display Mode, which hides the Viewer and moves the Node Editor to the right of the
Gallery, enlarging it considerably. Right-click and choose Toggle Display Node again to
return to the default layout.

= You can toggle Display mode using the DaVinci control panel by pressing SHIFT UP
and the DISPLAY/CURSOR button above the fourth trackball on the Center panel.

To zoom and pan within the Node Editor, do one of the following:
= Use the Node Editor’s zoom slider to shrink or enlarge the nodes in the Node Editor.

= Click the Pan tool (the hand icon) at the upper left-hand corner of the Node Editor, and
drag anywhere within the gray area of the Node Editor to pan around.

= Press the H key to toggle between selection and pan modes in the Node Editor.
= Middle-click and drag anywhere within the Node Editor to pan around.
= Right-click and choose Zoom In or Zoom Ouit.

= Right-click and choose Zoom to Window to fit the node tree to the current size of the
node graph.

= Right-click and choose Original Size to return the node graph to the default size.

The Node Editor’s Pan (Hand) tool

Ambitious grades may require trees of multiple nodes to create the necessary effect. This
section covers the mechanics of putting nodes together into the structures that are described
in more detail later in this chapter.

Every node you add is a “Corrector” node, which is capable of either primary or secondary
correction, depending on whether or not you enable the Qualifier/Window/Matte controls. Even
“Serial” and “Parallel” nodes are simply Corrector nodes that are added in series or in parallel to
the previous node in the node tree; the names are a consequence of how they’re added.

Each Corrector node has two inputs and two outputs, which lets you separately manage the
RGB image-processing channel, and the Key channel that defines areas of isolation for image
processing operations, or transparency for compositing. RGB inputs and outputs are light green
and round, located at the top left and right of each node. KEY inputs and outputs are blue and
triangular, located at the bottom left and right of each node. These inputs and outputs let you
control the flow of image and isolation channels coming into and going out of each node

in the tree.
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A single node, the round RGB and triangular
KEY inputs and outputs are clearly visible

Nodes are attached to one another via “connections,” seen as lines that connect one node to
another. Image data flows from left to right, starting with the Source input all the way at the left
of the Node Editor, through each node in the tree, and ending at the Node Tree output at the
right of the Node Editor.
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A simple serial arrangement of corrections

Here’s an explanation of the different components of a basic node tree where all nodes are
connected in serial, one after the other, and how they work together:

. The green source node to the far left is the clip’s image data as
processed by the Sizing and Source decode settings, ungraded. The Source input
feeds RGB data to the grade, and is connected to the RGB input of the first node in
your tree. If necessary, you can connect the Source input to more than one Corrector
node, creating multiple simultaneous streams of image processing emerging from the
original source state of the image that you can eventually recombine in different ways
using the Parallel or Layer Mixer nodes.

. Each node in the node graph represents a collection of image processing
operations that can be enabled or disabled separately from any other node in the
graph. By separating operations into multiple nodes, you're able to precisely control
the order of all image processing operations in Resolve to create many different
corrections and effects. The round green RGB inputs and outputs are used to connect
these nodes together. Each node’s thumbnail image shows how the clip looks at that
particular stage of the grade, giving you a visual indication of what each node is doing,
and small badges below each node show you which specific operations are being
applied by that node.

. The round green inputs and outputs at the upper right and
left of each node are used to connect the RGB image that’s output from one node
to the RGB input of the next node. For a Corrector node to have an effect, you must
connect both its RGB input and its RGB output to neighboring nodes in the tree.
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Furthermore, every single node in the Node Editor must be connected for a grade to
be enabled; having any disconnected node in the node tree disables that grade until
it’s fully connected.

- The blue triangles at the bottom right and left of each node
are used to route the key channel generated by a node’s Qualifier or Window controls,
or imported via a Matte clip that you previously associated with a clip in the Media
page. When you connect the Key output of one node to the Key input of another, you
basically copy the first node’s key to the second node. You can also combine the Key
outputs of multiple nodes in various ways using the Key Mixer node.

. The RGB output of the last node in a tree must be connected to the
green Node Tree output node, which “completes the circuit” of image processing, and
passes that correction on to the next stage in the DaVinci Resolve image processing
pipeline. If the output is not connected, the node tree is disabled and has no effect on
the clip. You can only connect one RGB output at a time to the Node Tree output.

. You can access the alternate highlight exposure of RED
HDRx media by exposing this optional second Source input. For more information, see
“RED HDRx Input Support” later in this chapter.

- It's possible to create regions of transparency for compositing directly
in DaVinci Resolve by connecting a Key output to an optional Alpha output. For more
information, see later in this chapter, “Manipulating and Combining Keys.”

Nodes appear with various labels and badges to help you identify what each node is
contributing to the overall grade. How long a label and how many badges appear depends on
the size of each node, as set by the Node Editor’s Zoom slider.
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Nodes showing the kinds of labeling and badges that are available for
identifying what operations each node is performing

- Nodes are numbered in the order in which they appear in the node
graph, making it possible for you to select specific nodes by number via the DaVinci
control panel. If you insert new nodes or rearrange existing nodes, the node numbering
will change to reflect each node’s new order

. As you apply various operations within a node, small badges
appear at the lower right-hand corner underneath the node. How many badges will
appear depends on how far in or out you’re zoomed in the Node Editor, and whether
or not there’s a Color Space label; at larger sizes, more badges can appear at once.
Each palette in the Color page has a unique badge. If you apply more operations than a
node has area to display, a single “downward arrow” badge appears.

. If you switch a node to use a color space other than RGB, that color
space’s three letter label appears at the lower left-hand corner of the node.
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Labeling Nodes

Nodes can be labeled to identify a particular node’s function in your grade. This can make it
easier to revise a grade months later. Node labels are also saved when you save a still, so
labels can also make it easier to decipher a saved grade down the road. At each node’s default
size in the Node Editor, nodes can appear with up to 12 characters of text, although larger
nodes can accommodate more text.

To label a node:
Right-click a node and choose Change Label.

Type a label above the node and press Return.

The label you entered appears above the node in the Node Editor. Once a node has a
label, you can change the label at any time by double-clicking it.

The node that’s currently selected in the Node Editor is highlighted in orange, and is referred to
as the current node. When you adjust any of the parameters or settings in the Color page,
you’re adjusting parameters within the current node. You can only select one node at a time.

To select a node, making it the current node, do one of the following:
= Double-click any node in the node graph.
= Choose Nodes > Previous Node (Option-Shift-;) or Nodes > Next Node (Option-Shift-9).
When you do this, the last node loops around to the first one, and vice versa.
= Using the Transport panel of the DaVinci control panel, press the PREV NODE or
NEXT NODE buttons. When you do this, the last node loops around to the first one, and
vice versa.

= Using the Transport panel of the DaVinci control panel, enter the number of the node
you want to select using the keypad, and then press the SELECT NODE button.

The selected node appears highlighted in orange. You also have the ability to select multiple
nodes, in preparation for doing things like moving them or creating compound nodes (covered
later in this chapter).

To select multiple nodes:
= Command-click each of the nodes you want to simultaneously select.

= With the Node Editor Selection tool chosen (at the upper left-hand corner of the Node
Editor) simply drag to select multiple nodes using a bounding box.

The Node Editor’s Selection tool

When you select multiple nodes, each one appears with a red highlight above it.

Selecting three nodes by dragging a bounding box
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When you select another clip in the Timeline, the default behavior is that the last node that was
selected when you worked on that clip is the one that’s selected when you move to that clip
again. However, a setting in the Project Settings window, “Switching clips,” lets you change this
behavior. For more information on this option, see Chapter 3, “Project Settings and Preferences.”

In the process of creating a node tree, it’s often useful to turn nodes off to disable their effect
on your grade. It’s also useful to turn the entire node tree off and on in order to see “before and
after” views of the current clip. Disabled nodes are not processed during rendering, and they
remain disabled when you save that grade along with a still in the Gallery and then apply that
grade to another shot.

To toggle individual nodes off and on:
= Click the number of any node in the node graph to disable that node by itself.
= Select a node, and choose Nodes > Enable/Disable Current Node (Command-D).
= On the DaVinci control panel, press the DISABLE CURRENT button (on the T-bar panel).

To turn every node off and on at once:
= Choose Nodes > Enable/Disable All Nodes (Option-D) to toggle all nodes off and on.
= On the DaVinci control panel, press SHIFT-DOWN and then the DISABLE CURRENT
button (on the T-bar panel).

When you turn every node off and then on again, every node is re-enabled, even
nodes that had previously been individually disabled.

You can also use a separate command to disable grading altogether. This is useful if you've
toggled specific nodes off in the node tree, and you want a before and after look at the node
tree with those nodes turned off. When Bypass All Grades is enabled, grading is disabled for all
clips in the entire Timeline until you disable it.

To toggle grading off and on, do one of the following:
= Click the Disable Grading button at the upper left-hand corner of the Node Editor.
= Choose View > Bypass All Grades (Shift-D)

If you're dissatisfied with your current operations and want to start over, there are three ways
you can reset nodes in the Node Editor. These are available as items in the Color menu, and
buttons on the DaVinci control panel’s T-bar panel.

. Resets the currently selected node, eliminating all
keyframes, to the default parameter settings.

. Resets every node in the current node tree, without
affecting the node tree’s structure; all nodes remain where they were. However, each
node has been reset to the default parameter settings.

- Deletes every node and keyframe, and restores a single
node set to the default parameter settings.

You can also reset nodes using the mouse, which can be a quick thing to do if you're already
working in the Node Editor to accomplish other things.
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Methods of resetting nodes with the mouse:

- Right-click that node and choose Reset Node Grade from the
contextual menu.

- Right-click anywhere in the background of the Node
Editor, and choose Reset All Grades and Nodes from the contextual menu.

There are two other methods of quickly dealing with unwanted changes you’ve made to node
trees, without needing to use undo.

- Lets you preview the effect of any saved grade on the current clip.
To preview, choose Color > Preview Memory (Option-Shift-P), and then right-click any
saved still in the Gallery (or Memory) and choose Add Correction. In fact, you can use
Add Correction to try out as many stills as you like. If you like any still's effect, then you
can leave it be. If you don’t like any of the stills you previewed, then choosing Color >
Preview Memory again reverts the clip to the original grade.

. This command lets you quickly revert a clip’s grade to its original
state when you first selected that clip. This is useful for getting immediately back to a
clip’s original grade if you’ve made a series of changes that you then regret. Selecting
another clip in the Timeline and then reselecting the clip you made changes to resets
what is considered to be the current grade.

You can flag specific nodes to be cached, along with all nodes appearing upstream in that node
tree. By caching nodes using processor-intensive effects, you free up real time capability for the
remaining downstream nodes in a grade. Choosing Playback > Render Cache > User only
caches nodes that you've flagged for caching.

When you choose Playback > Render Cache > Smart mode, Resolve automatically caches any
nodes that use Motion Blur, Noise Reduction, or OFX plug-ins, without you needing to
do anything.

To flag a node and all corrections made in upstream nodes for caching:

= Right-click any node and choose Node Cache > On from the contextual menu.

There is no limit to the number of nodes you can create and connect to one another, and you
can make as many or as few parameter adjustments as you like within each node. The following
procedures describe the ways you can add nodes to the node graph as you build each grade’s
node tree.

Adding Nodes

The simplest thing you can do to add to the complexity of a node tree is to add additional
nodes, in order to add more adjustments to the current grade. You can add nodes so that
they’re automatically attached to nodes that are already in the node tree, for immediate
adjustment, or you can add unattached nodes to empty areas of the node tree in preparation
for assembling a particularly complicated and specific node tree to accomplish a difficult task.
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Methods of adding nodes to the tree using a mouse, tablet, or trackpad:
- Right-click any node
in the node tree, and choose the type of node you want to add from the Add Node
submenu of the contextual menu.

. Right-click anywhere within the node

graph’s background, then choose Add Node > Corrector from the contextual menu.
Disconnected nodes have no effect on a node tree until they’re connected.

Methods of adding nodes to a currently selected node in the tree using the keyboard or
control panel:

. Press Option-S key, choose
Nodes > Add Serial from the menu, or press the ADD SERIAL button on the T-bar panel
of the DaVinci Resolve control panel.

. Press Option-K, choose
Nodes > Append Node from the menu, or press the APPEND NODE button on the
T-bar panel of the DaVinci Resolve control panel.

- Press Option-S, or choose
Nodes > Add Before Current, or press SHIFT DOWN and then ADD SERIAL on the
T-bar panel of the DaVinci Resolve control panel.

- Press Option-P, choose Nodes
> Add Parallel from the menu, or press the ADD PARALLEL button on the T-bar panel of
the DaVinci Resolve control panel.

. Press Option-L, choose Nodes > Add
Layer from the menu, or press the ADD LAYER button on the T-bar panel of the DaVinci
control panel.

. Press Option-0O, choose
Nodes > Add Outside Node from the menu, or press the ADD OUTSIDE button on the
T-bar panel of the DaVinci control panel.

Adding Nodes with Windows Turned On

There are also dedicated commands for adding serial nodes with Circular/Linear/Polygon/Curve
windows automatically turned on, for convenience.

To add a node to the tree with a Window automatically enabled:

Choose an item from the Nodes menu, or press the button on the T-bar panel of the DaVinci
Resolve control panel that corresponds to the following:

. Circular Power Window (Shift-C)

- Linear Power Window (Shift-Q)

. Polygonal Power Window (Shift-G)
. PowerCurve Window (Shift-B)

Whenever you add a node to a tree, it's numbered consecutively to come after the next most
recent node you'd added, regardless of the order in which it appears in the node tree. For
example, if you've already added three nodes, and then you decide to add another node in
between Nodes 1and 2, the new node will be Node 4, and the order of the nodes will be 1,
4,2,and 3.
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Deleting Nodes

If there’s a node that you no longer need, you can choose to remove it completely from the
node tree to remove its effect permanently.

To delete a node, do one of the following:
= Select a node, then press the Forward-Delete key.
= Right-click a node, and choose Delete Node.
= Using the DaVinci Resolve control panel, select any node, and press the DEL-CURRENT
button (on the T-bar panel).

After you've deleted a node, the node to the left and right of the node you deleted are
automatically connected so that the node tree is unbroken. Also, all the nodes in a tree are
renumbered after the deletion of any node, so there’s no discontinuity in node order. For
example, if you have three consecutively numbered nodes in a tree and you delete the second
one, the node that was formerly number 3 is renumbered to be 2.

Connecting and Disconnecting Nodes

For a node tree to work, every node in the Node Editor must be connected into a working node
tree, from the Source input, through each node in the tree, to the Node Tree output. Any
disconnected node will result in that clip’s grade being disabled. However, you may find the
need to disconnect some parts of a node tree in order to reconnect them in different ways.

To connect two disconnected nodes:
= Click-and-drag a connection from the RGB or Key output of one node to the
corresponding RGB or Key input of another, and when the line highlights, release the
mouse button.
To disconnect two nodes:

= Click a link to select it (selected links turn orange), and then press the Delete or
Forward-Delete key.

= Right-click a link and choose Delete Link.

To overwrite a node’s previous connection:

= You can drag a connection to a node input or output that’s already connected, which
will overwrite the previous connection with the new one you're dragging. When you do
this, the connection that’s about to be overwritten appears highlighted in orange.
You can connect any node’s RGB or Key output to as many inputs as you want, but you can only
have one connection going to a node’s input. The exception to this is a node with multiple
inputs, designed to combine the output of multiple nodes. These include the Parallel, Mixer, and
Key Mixer nodes.

Extracting a Node

Sometimes you need to remove a node from its current position in the node tree, such that the
nodes to the left and right of it automatically reconnect to one another, saving you from having
to reconnect them manually. This is called extracting a node.

To extract a node, do one of the following:
= Select a node, and choose Nodes > Extract Current Node.
= Select a node, and press E.
Keep in mind that disconnected nodes in the node tree suspend grading altogether, so you'll

want to either reconnect that node to another part of the node tree, or delete it; you cannot
leave it disconnected in the Node Editor.
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Inserting a Node

If there’s a disconnected node in the Node Editor, there’s a simple way you can insert it into the
node tree between any two other nodes. This also works for nodes that you're dragging into a
node tree from another source, for example, from the exposed node tree of a still in the Gallery.

To insert a disconnected node between two other nodes:

= Drag a disconnected node, or a node from another node tree, onto the connection
between any two other nodes in a node tree; when a plus icon appears over the node
you're dragging, drop it to insert the node.

Rearranging Node Order

The order in which nodes are connected in your tree affects the result of a grade. For example,

if you boost the highlights in the first node, and then you try to isolate a portion of the picture in

a second node that you now realize has been clipped, you may to need to change your order of
operations to optimize your corrections.

To swap the contents of two nodes:

Command-drag any node and drop it onto another node to swap the operations within each
node. The nodes won’t appear to have moved, but you should be able to tell from the node
badges underneath that the operations have been reversed.

To move a node to any other position in the node tree:

Double-click any node in the node tree and press E to extract it, removing it from the
tree so that it becomes unattached.

Drag the now-unattached node to the connection line between any two other nodes in
the tree, and when a small plus icon appears, drop it to automatically connect that node
at that position in the node tree.

Keeping Node Trees Organized

It's a good idea to keep the arrangement of your nodes in the node graph clean and neat. It’ll
make it easier to read your tree if you need to revisit a grade later on, and it will also make it
easier for other colorists working on the same project to figure out what you're doing. The
following procedures describe how to rearrange the nodes in your tree, and the node tree
working area, to help you keep on top of your grades.

To move nodes within the Node Editor:
= Drag any node to a new position.

= Command-click or drag a bounding box around multiple nodes that you want to move,
and drag them all to a new position.
Of course, it’s easy to get carried away. If you’ve been working furiously on a complex grade
and you find yourself staring at a riot of disorganized nodes, it's easy to quickly reorganize your
node graph using a pair of commands in the Node Editor contextual menu.

To clean up the node graph, right-click the Node Editor and choose one of the
following commands:

. Moves all nodes in the node graph so they appear
in an evenly spaced grid. Connection lines are curved around nodes to minimize clutter.

. Moves all nodes in the node graph so they
appear in an evenly spaced grid. Connection lines cut across nodes as necessary.
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Before/After using “Cleanup node graph with curves”

Identifying Nodes

As you make various adjustments to nodes, small badges appear underneath that indicate what
that node is actually doing. Since nodes are capable of holding multiple adjustments, any given
node may have multiple badges; how many badges a node can show depends on the zoom
level of the Node Editor. Larger nodes will show more badges, whereas smaller nodes will show
fewer badges, hiding whichever badges don't fit.

Badges underneath each node indicate
which adjustments it contains
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Another nice organizational feature of the Node Editor is an automatic tooltip that appears
whenever you hover the pointer over a particular node, that shows you a concise list of all the
operations applied to that particular node.

Grading Order of Operations

As you construct grades more carefully in the Color page, it may help you to know what the
precise order of operations are in the image processing pipeline of DaVinci Resolve. While you
can control the order of operations for node-specific adjustments by being careful about what
you do in which nodes, the order of Pre-Grade, non-node specific, and Post-Grade operations
are all fixed.

Operations that take place before nodes

Resolve Color Management Input to Edit
Camera Raw Timeline Color Space Conversion =24 Input LUT ’} Siziln
or ACES IDT 5

Operations that take place within nodes

v
O ¢ Sé%léz PR ¢ ............. OpenFx  [NE— Lo —
............. N Ga;,gtéa, ............. N Contrast/. J— N Custom  J— N EAEST?S% ............. }

Node q Channel HSL 1D or 3D
B0 0D 8B B

Resolve Colour Management to
Output Color Space Conversion
or ACES RRT to ODT

Output
Sizing

Deliver Page
Output

Color Page
Display LUT

The order of image processing operations in DaVinci Resolve
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Copying Nodes and Node Settings

You may save time when assembling complicated node trees by recycling nodes or node
settings from previous grades.

When constructing node trees, you may sometimes find it necessary to copy nodes from one
clip’s grade to another. This can be accomplished by exposing the node tree of any still that’s
saved in the Gallery, or any clip in the Thumbnail timeline, and copying individual nodes from
the exposed node tree to the Node Editor.

Dragging a node from a node graph to the Node Editor

To copy individual nodes from any still in the Gallery:

Right-click a still in the Gallery, and choose Display Node Graph. A Node Graph window
appears displaying that still's node tree.

While the Gallery Node Graph window is open, you can select any other still, and this
window will update to show the currently selected still's node graph.

Once you've found the node tree you're looking for, drag any node from the node tree
directly over any connection line in the Node Editor. When a small plus icon appears over
the Corrector node icon you're dragging, drop the node to insert it into that connection.

Click Exit when you're finished.
To copy individual nodes from any clip in the Timeline:
Click the thumbnail in the Timeline of the clip to which you want to copy nodes.

Right-click the thumbnail of the clip you want to copy nodes from, and choose Display
Node Graph.

NOTE: The Display Node Graph command only appears in the contextual
menu of a clip in the Thumbnail timeline that is not currently selected.

Drag any node from the node tree directly over any connection line in the Node Editor.
When a small plus icon appears over the Corrector node icon you're dragging, drop the
node to insert it into that connection.

Click Exit when you're finished.
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Using this mechanism, you can also copy every node in the node tree using the Apply Color
button, copy just the Sizing (Pan/Tilt/Zoom/Rotate parameters), copy the Source settings of that
clip, or copy all using the Apply buttons to the right of the node graph.

You may also find yourself needing to copy one node’s settings to another node. In particular,
this is the only way of copying tracking data or keyframes from one node to another, either
within the same grade, or from one grade to another.

To copy a node’s settings to another node using keyboard shortcuts:
In the Node Editor, select the node with settings you want to copy, and choose Edit >
Copy (Command-C).

Select the node you want to paste these settings to, and choose Edit > Paste
(Command-V).

To copy a node’s settings to another node via drag-and-drop:

Option-drag one node onto another. When you drop it, the settings of the node you
dragged overwrite those of the node you dropped onto.

Serial, Parallel, and Layer
Node Tree Structures

There are several ways you can organize nodes in a tree. Each method lets you control a group
of image processing operations in different ways to achieve specific results. This section covers
how to use Serial nodes, Parallel nodes, and Layer nodes, as well as how to use LUTs, work
with HDR media that lets you combine two different exposures using two different Source
inputs, and apply additional project-wide adjustments using the Timeline grade.

The simplest, and most common node structure is a serial cascade of nodes, where a linear
series of nodes is connected, one after another.

Serial nodes, the output of one node goes into the next

Much of the time, this method of constructing a tree of multiple operations is all you need to do.
It's a simple and intuitive way of organizing your adjustments, similar in principle to the stacks of
layers used in other grading and compositing applications to apply multiple operations to a clip.
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Controlling What Feeds a Node’s RGB Input

When you create a grade using serially arranged nodes, each node’s output is used as the next
node’s input, so the order in which the nodes are arranged determines the order of image
processing operations.

In the following screenshot, the node tree shows a series of three operations that are applied to
a log-exposed, low-contrast clip. The first node expands clip contrast and increases saturation.
The second node isolates the sky to intensify its color. The third desaturates and warms the
image. At right, you can see the result of this node tree.

Node two pulls a clean key from the image data fed it by node one

If, instead, we reversed the order of Nodes 2 and 3, the result will be a less effective key.

By comparison, node three pulls a less then optimal key
from the image data fed it by node two

Because the secondary operation is sampling the desaturated image, rather than the source,
the HSL Qualifier’s key has less image data to work with, and thus you get an inferior result.

Another way to organize your corrections is to use a Parallel node structure, which lets you
apply two or more overlapping adjustments at a single stage of a node tree. You can use the
Parallel node structure for organizational reasons when there is a group of secondary
corrections that you want to apply all at once. You can also use this structure for the unique way
it blends overlapping image adjustments.

The Parallel Mixer node that makes this possible has multiple RGB inputs and a single RGB
output. This lets the Parallel Mixer mix together multiple Corrector nodes, outputting a single
image as a result.

When you add a Parallel node to an existing node, DaVinci Resolve automatically adds one
Corrector node below the current node, and adds a Parallel Mixer node to its output.
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Adding a Parallel node to Node 2 automatically adds the Parallel Mixer

If you want to create a series of Parallel nodes that connect to the output of the
currently selected node, create a Serial node before you create your first
Parallel node.

If you're manually connecting another node to a Parallel Mixer node, you must first create an
additional input to connect it to.

To create an additional, unconnected input on a Parallel Mixer node:
= Right-click a Parallel Mixer node and choose Add One Input.

Ordinarily, the RGB input of every Corrector node that’s connected to a Parallel node is
connected to the output of the same node. This results in a stack of nodes that take the same
state of the image as their input. This makes it easy to apply multiple secondary operations
without worrying about whether or not a change to one will affect the keys of the others.

Further Parallel nodes can be added as you wish
with each using a common source
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If you add another node in parallel, the Parallel Mixer automatically adds another input. You can
have as many nodes in parallel as you need.

The adjustments made by all nodes that are connected to a Parallel Mixer are combined
equally, regardless of which nodes are highest. In the following example, a separate
overlapping Window is applied by each of three nodes in parallel.

Parallel

The Parallel Mixer blends all input nodes together

As you can see in the image at right, the three tints created by the overlapping Windows are all
mixed together equally; the colors blend with one another as if they are optically mixed. Most of
the time, this is exactly what you want when you're blending overlapping naturalistic color
adjustments.

Converting Parallel Mixers to Layer Mixers

On the other hand, if you need your overlapping color adjustments to have priority over one
another, or if you want to combine multiple adjustments using composite modes, then you may
want to use the Layer Mixer node instead. If you've created a Parallel Mixer structure and you
want to convert it to a Layer Mixer, you can.

To change a Parallel Mixer node into a Layer Mixer node:

= Right-click a Parallel Mixer node and choose Morph Into Layer Mixer Node.

The Layer Mixer is structurally quite similar to the layout used by the Parallel Mixer. However,
there are two key differences. First, the Layer Mixer node combines multiple adjustments with
priority given to the image adjustment in the lowest overlapping node input. Second, you have
the option of combining all of the Corrector nodes that are connected to a Layer Mixer using
one of several different composite modes, to create a wide variety of visual effects.
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Because of their similarities, layering nodes with the Layer Mixer works in much the same way
as creating a Parallel node structure.

Layer Mixer Prioritization

In the following example, the same node structure from the Parallel Mixer example is shown,
this time with the three overlapping color adjustments mixed together using the Layer Mixer.

The Layer Mixer prioritizes nodes connected to lower inputs such
that each node’s output completely obscures whatever is behind it

Now, instead of the three adjusted color tints being blended, you can see that the blue tint,
which is connected to the lowest input of the Layer Mixer, is dominant and covers the
overlapping regions of the two other adjustments. Meanwhile, the green tint, which is
connected to the middle input of the Layer Mixer, covers the overlapping portion of the orange
tint, which is connected to the highest input of the Layer Mixer.

Rearranging which connections are attached to which Layer Mixer inputs changes each node’s
priority, and like the Parallel Mixer, you can add more inputs if you need to connect more
nodes manually.

The Layer Mixer’s prioritization is most useful when you have an overlapping adjustment that
you need to override any other adjustments happening on that stack. In the following example,
two nodes are connected to the Layer Mixer node. Node 2 is applying a high-contrast, cool
look to the entire clip. Node 3 isolates the skin tone, which is unflattering with the background
stylization, and applies a different, more naturalistic adjustment.
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Using the layer mixer, grades on Node 4 will have a greater priority over Node 2, so the final
grade combines the high contrast from Node 2 with the adjusted skin tone from Node 4

Because of the Layer Mixer’s prioritization, the adjustment made to the woman’s skin tone
completely covers the adjustment made to the node that comes above it, providing the best of
both worlds with one simple adjustment.

If you want to “solo” overlapping nodes that are connected to the Layer Mixer to
see their individual adjustment, turn on Highlight (Shift-H, or the HILITE button on the
Transport panel of the DaVinci control panel). This lets you view just that node’s effect,
regardless of what other nodes adjustments are overlapping.

Using Composite Modes With the Layer Mixer

You have the option of combining the adjustments made by all nodes connected to a Layer
Mixer node using the same Composite modes that are available when compositing clips in the
Timeline. This lets you combine different overlapping image adjustments using compositing
math to achieve creative effects or utilitarian fixes.

The following simple example shows two overlapping Corrector nodes connected to a Layer
Mixer node that’s set to the Add composite mode. Node 3 has no adjustment, but Node 5 has
an extremely high-contrast curve adjustment applied, along with a blur, that effectively isolates
the highlights of the image and feathers them out.
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Combining two nodes using the Layer Mixer
set to Add to create a glowing effect

By adding both treatments together, a hot glow has been created, blowing out the highlights of
the image. Many, many other effects are possible using the different composite modes that are
available. For more information on composite modes, see Chapter 19, “Edit Page Effects.”

Adjusting Layer Node Strength Using Key Output Gain

Whether you’re combining overlapping corrections, or mixing different adjustments using
Composite modes, you'll run into situations where you want to reduce the influence of one
overlapping adjustment relative to the other nodes that are connected to the Layer Mixer node.
This can be accomplished using each overlapping node’s Key Output Gain parameter, located
in the Key palette.

Key Output

1.000

Using the Output Gain parameter in the Key palette

Key Output Gain defaults to 1.00, but lowering this value reduces the strength of that node’s
contribution to the Layer Mixer. Using the previous example, selecting Node 4 (the high-
contrast image used to create the glow), opening the Key palette, and reducing the Key Output
Gain parameter to 0.50 reduces the intensity of the Glow effect by half.

You can use Key Output Gain to mix the proportion of any number of overlapping adjustments
in order to create the perfect combination for your purposes.
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You can also use the Key Output Gain parameter to mix the proportion of
adjustments being combined using the Parallel Mixer node.

Converting Layer Mixers to Parallel Mixers

You can easily convert a Layer Mixer to a Parallel Mixer should you discover that you need to
mix your overlapping corrections evenly rather then combine them with priority. Keep in mind
that you'll lose the ability to use Composite modes.

To change a Layer Mixer node into a Parallel Mixer node:

= Right-click a Parallel Mixer node and choose Morph Into Parallel Node.

Applying a LUT Within a Node

Look up tables (LUTs) are frequently used to create a starting point adjustment for media
acquired with some sort of logarithmic (log) exposure. DPX log film scans, digital media using
the ARRI' ALEXA’s Log-C encoding, Sony’s S-Log exposure setting, or RED R3D media that is
debayered using the REDFilmLog setting are all examples of media using a logarithmic
exposure curve, designed to protect as much detail in the highlights and shadows of a digitally
encoded image as possible. While log-encoded media retains a lot of image data, the picture is
initially flat and unsuitable for use without grading. The exposure and color must be adjusted to
“linearize” the media, making it look the way it’s supposed to, in order to start grading. You can
do this manually, or, as a shortcut, you can use a LUT that’s tailored to your type of media and
the exposures you're using.

LUTs are also commonly used in onset workflows where dailies are managed with
corresponding LUTs. These LUTs were used to monitor the media as it was being recorded, and
define a baseline reference for how each scene is meant to look, at least so far as field
monitoring is concerned.

In either instance, LUTs, when used in this way, are adjustments that are applied to affect the
look of a clip, in much the same way as you'd make adjustments using any of the contrast or
color controls in the Color page. While there’s an entire group of LUT controls in the Look Up
Tables section of the Project Settings, those are designed to apply LUTs, in different parts of
the image processing pipeline, to the entire Timeline. This is useful when you want to apply a
single color and contrast transformation to the entire program at once, but less so if you want to
apply different LUTs on a per clip basis. (For more information on using the Look Up Table
settings, see Chapter 3, “Project Settings and Preferences.”)

DaVinci Resolve lets you apply LUTs within a grade by connecting a LUT to a particular node in
the Node Editor.

To apply a LUT within a node:

= Right-click any node, and choose a LUT from the 1D Input LUT, 1D Output LUT, or 3D
LUT submenus.

LUTs that you apply using the 3D LUT or 1D Output LUT submenus impose their transformation
after all other Color page adjustments applied by that node. This means that you can use Color
and Contrast controls to trim whatever effect the selected node’s LUT is having on the image.
For example, if the contrast adjustment made by an applied LUT clips the highlights of the
image too much, you can use that node’s Contrast controls to lower the highlights, restoring
detail to the image.

Chapter 30 — Working in the Node Editor

843



The LUT submenus list whichever LUTs have been installed on your workstation. For more
information on installing LUTs, see Chapter 3, “Project Settings and Preferences.”

Using Compound Nodes

Another node structure you can use to keep complex node trees organized is the compound
node. You can Command-click to select any number of nodes in the node tree (selected nodes
are highlighted red), and then use the “Create Compound Node” command to nest all selected
nodes inside of a single node.

ul ©H

Compound Node

nl ©H

Before/After creating a Compound node

The resulting compound node that’s created has as many inputs and outputs as are necessary
to accommodate the connection lines that attached the nodes you selected to the rest of the
node tree.

You can use compound nodes to organize complicated node trees by nesting sets of nodes
that work together to do a specific thing within a single node. You can also turn a set of nodes
that you're using to create a specific effect into a compound node in preparation for saving to
the Gallery. Creating a library of effects in this way makes it easy to reuse them via the Append
Grade command, without the undue burden of adding lots more nodes to your grade later on.

Methods for creating and working with compound nodes:

. Command-click each node you want to nest inside of
a compound node to select them with a red highlight. Then, right-click one of the
selected nodes, and choose Create Compound Node from the contextual menu.

. Either hold the Command key down while double-clicking
the compound node you want to open, or right-click any compound node and choose
Show Compound Node from the contextual menu. The contents of that node appear in
the Node Editor, taking the place of the overall node tree.
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. To return to the top level node tree, click the
left-most item in the path control at the bottom of the Node Editor.

. Right-click a compound node, choose Change Label from
the contextual menu, and type a new label for that node. Press the return key when
you're finished.

. Right-click the compound node you want to
decompose, and choose “Decompose Compound Node” from the contextual menu.
The compound node disappears, replaced by the original nodes within. Please note,
if you had applied an adjustment to the compound node itself, that adjustment is lost
when you decompose it back into its constituent nodes. If you want to preserve the
compound node adjustment itself, you can copy it, then decompose the node, and then
create a new node and paste the adjustment you'd copied.

When you open the contents of a compound node using the Show Compound Node command,
you can make whatever adjustments you like to the node tree within, but you also have the
option of right-clicking within the Node Editor and choosing Add Source to add an input to the
compound node, or Add Output to add an output. Adding more inputs and outputs lets you set
up the node to connect to the rest of your node tree in more complicated ways. Disconnected
inputs and outputs have no effect on your grade.

Furthermore, you can also use the Add Alpha Source and Add Alpha Output contextual menu
commands to add KEY inputs and outputs to a compound node, making it easy to route key or
alpha channel data to other connections in the enclosing node tree.

Compound nodes can also be nested within other compound nodes, if necessary.

After you've created a compound node, you can select it to make one or more adjustments
using the compound node itself, which effectively adds those adjustments after all other
adjustments that take place via the nodes that are inside of the compound node. This gives you
the opportunity to “trim” the effect that compound node is having on your grade, or to limit it
using a Qualifier or Window.

To adjust the individual nodes nested within a compound node, you need to first open the
compound node. Then, you can select and adjust any node as you ordinarily would.

RED HDRx Input Support

The RED EPIC, SCARLET, and DRAGON cameras are capable of shooting in an HDR mode that
effectively “brackets” two different exposures of each frame. The resulting image data stores
two channels of image data: the regular exposure, and a “highlight exposure” that’s
underexposed by a user-selectable margin (+3, +4, +5, or +6 f-stops difference).

By default, the Input bar in the node graph feeds the regular exposure to your grade’s node
tree. To take advantage of the additional “highlight” exposure, you can add an additional
Source input to the node graph that feeds a second stream of image data that you can mix with
the regular exposure in different ways.
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NOTE: You can also take advantage of the highlight exposure of RED HDRx media by
enabling and adjusting the Magic Motion controls in the Camera Raw palette.

To set up a node tree combining the normal and highlight HDR versions:

Using the first default node (Node 1), grade the image to see if you even need to use
the alternate exposure that’s available. We’ll assume for this example that you do. In this
example, the sky of the default exposure is pretty blown out, but there may be detail
that can be retrieved using the highlight exposure.

Using HDRx images with the Layer Mixer

Create a Layer Mixer node by choosing Nodes > Add Layer (Option-L), or press the
ADD LAYER button of your control panel.

Two nodes are created, a Layer Mixer node that’s added after Node 1, and a third node
(Node 3) that’s connected to a second RGB input of the Layer Mixer node in parallel
to Node 1.

The Source currently supplies two input, but you can add a
second source which is the short exposure in the HDR image

Right-click anywhere within the node graph (except on a node) and choose Add Source
from the contextual menu.

A second Source input appears underneath the first, which outputs the highlight
exposure of the image as a separate image stream.
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A node tree that uses a Layer Mixer node to mix two Corrector nodes,
each connected to separate outputs for the regular and highlight exposures.

Delete the connection between the top Source input and Node 3, and then connect
the bottom Source input to the RGB input of Node 3.

Immediately, the image in the node thumbnail and Viewer updates to show the darker,
underexposed version of the HDR image. This is because, by default, the Layer Mixer is
mixing 100% of Node 3 over Node 1.

Select Node 3 and use one of the following two procedures to create a useful
combination of the two exposures:

To create a mix of the two exposures, open the Key tab, and drag the Key Output Gain
slider to lower the contribution of Node 3 to the overall image (you can also do this
using the DaVinci control panel by pressing the KEY MODE soft button, and then using
the Post Mix Gain rotary control). Using dynamics (keyframing), this is a good way to
animate a dissolve from the regular exposure to the highlight exposure if you're going
from a dark environment to a bright environment in the same take and you want to
create a smooth transition between both exposures.

Key Output

0.490

Dissolving between the regular and highlight exposures
of RED HDRx media using the Key Output Gain slider of a
Corrector node connected to a Layer Mixer node.

You can also use the Blend Type and Blend Bias parameters in the Camera Raw
palette to blend the two exposures without building a dedicated node tree.

To use the highlight exposure to selectively put detail back into the image (for example, to
retrieve blown-out windows), use a Power Window, HSL Qualification, or a combination of the
two to isolate the region you want to retrieve in Node 3. (Be careful if you're using HSL
Qualification to combine both exposures, as keyed edges can be tricky to blend.)
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Isolating a region of the image to replace using the highlight
exposure image of a RED HDRx clip

Final node display with isolations

A Note About RED HDRx Media and Performance

Since RED HDRx media records two complete streams of image data, DaVinci Resolve
must simultaneously decode two separate tracks whenever you add a second Source
input. (If you don’t add the second Source input, only the first stream is decoded.)

Because of this, whether you're relying on your computer’s CPU to decode RED
media, or you're using a single RED ROCKET card, you'll get half the performance
when using the highlight stream of an HDR clip.

To improve performance, you can set any RED HDRx clip’s Render Cache Mode to
“User” by choosing Playback > Render Cache > User, pressing Option-R, or pressing
the CACHE MODE button on the T-bar panel of your control panel repeatedly until you
toggle to User mode. DaVinci Resolve renders all cached clips in the background, so
the next time you play a cached clip, it will play at full speed.

If you regularly use RED HDRx media, two RED ROCKET cards are recommended for
optimal decoding performance.
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Clip vs. Timeline Grading

Ordinarily, the Node Editor has two modes. The default Clip mode lets you create individual
grades for each clip or group in the Timeline. However, the Timeline grade mode lets you apply
a single grade simultaneously to every clip in the Timeline, as seen in the Thumbnail timeline in
the following screenshot.

02| 00:44:48:12 V1 03] 1 04 00:46:25:04

A paragon of sophisticated grading, the author applies a red edge vignette to every
clip in the project simultaneously using the Timeline grade.

There are a variety of reasons you might want to do this. For example, if you're working on a
commercial spot, you might elect to use Clip grades to do general correcting and scene-to-
scene balancing, and then use the Timeline grade to apply a single stylistic grade to the entire
spot simultaneously. That way, any changes the client wants made to the style of the grade can
be instantly applied to the whole spot.

Another example would be using the Timeline grade to apply corrections meant to address QC
issues running throughout a program, desaturating highlights or selectively darkening a specific
shade of red wherever it appears.

To switch between Clip and Timeline grading modes:
= Choose the mode from the pop-up menu at the top right of the Node Editor.

Clip v

Timeline Ie

g

Selecting Track mode in the Node Editor

= Click the dot in the Node Editor toolbar that corresponds to the Clip or Timeline mode.

Two dots show whether you're in Clip or
Timeline mode; these can be clicked to switch

NOTE: When you reset the Timeline grade using the Color > Reset All Grades and
Nodes command, the Output Sizing parameters are reset as well.

Two dots at the top of the Node Editor let you switch between Clip and Timeline modes via a
single click. If you're working on a clip that’s part of a group, four dots will be displayed to allow
fast access to the Pre-Clip and Post-Clip Group modes as well. For more information about
group grading, see Chapter 28, “The Gallery and Grade Management.”
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Timeline Grades and Saved Stills

When you save a Gallery still, the Clip and Timeline grades are both saved. However, when you
apply a grade from that still, you only apply either the Clip grade, or the Timeline grade,
depending on which mode the Node Editor is in. For more information on saving and applying
grades, see Chapter 28, “The Gallery and Grade Management.”

Manipulating and Combining Keys

Each node’s key input and key output makes it possible to route key channel data from one
node to another so you can apply isolated corrections. Furthermore, the Key Mixer lets you
combine a variety of keys from different nodes to create more detailed keys with which to
tackle complex operations. This section covers all the ways you can recombine key data, as
well as how keys can be used in conjunction with the Alpha Output to create regions of
transparency in a clip for compositing right within DaVinci Resolve.

Whenever you use a Power Window or HSL Qualifier to limit a correction within one node, a
special node structure lets you automatically create a second node, called an Outside node, to
apply additional adjustments to the inverse of the region you isolated in the previous node.
Outside nodes make it easy to apply separate corrections to an isolated subject and its
surroundings.

In the following example, the sky has been isolated using a Power Window, and an Outside
node has been added to make an additional correction to everything else within the shot.

The Outside node automatically
has its key input inverted

To add an Outside node to a node, creating a secondary correction:

Select a node that has been limited using a Power Window or HSL Qualifier.
Do one of the following:

= Choose Nodes > Add Outside (Option-0).
= Right-click a node choose Add Outside Node.
= Press the ADD OUTSIDE button on the T-bar panel of the DaVinci control panel.

A new node is created immediately after the selected node, with the RGB and key outputs of
the first node automatically connected to those of the new node.

When selecting the new node and opening the Key palette, you can see that the Key Input’s
Invert control is on by default, which is what inverts the key from the previous node.
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The Key Input’s Invert control is on by default for each node

If, instead of inverting the incoming key, you want to copy the existing key in order to perform
another operation to the same isolated region, you can disable the key input’s Invert control.

One of the most powerful aspects of the Node Editor is the ability to create keys based on a
specific part of the node tree, and feed the result into a completely different correction
somewhere else in the node tree. This is one of the reasons for the separate key input and
output on every Corrector node.

The key that’s created whenever you use the HSL Qualifier, create one or more Windows, or
use an external matte can be output from one node’s key output and fed to the key input of any
other node in a tree. There are many reasons to do this, but the following example shows a
common problem you can solve with this technigue.

Using a key from one node to make an adjustment with a different node:

Use Node 1to apply a basic primary correction, increasing contrast and balancing the
color to achieve a pleasing ambient color temperature.

Add a Serial node (Node 2), followed by a Layer Mixer node which also adds Node 4
(as seen in the following screenshots). Then, completely desaturate Node 4 and add
contrast make it super-high contrast black and white, desaturate Node 2 just a bit,
and right-click the Layer Mixer node to choose the Overlay blend mode with which to
combine these two layers.

Serial nodes to create a stylized image
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The result is a highly stylized image, but the skin tone on the actor’s face and hands in
the resulting image are too monochromatic, and you want to give them some
differentiation. Simply adding another node after the Layer Mixer and keying the skin
tone may not work well because the low level of saturation will make a key difficult

to pull.

The resulting stylized image may
be difficult to key accurately

Add another node after the Layer Mixer (Node 5 in the screenshot), and then right-click
in the gray background area of the Node Editor, and choose Add Node > Corrector to
create an unattached node, (Node 6).

Connect the RGB output of Node 1to the RGB input of Node 6, and then connect the
Key output of Node 6 to the Key input of Node 5. Now you’re ready to pull a high-
quality key from the very first correction in Node 1, skipping all the complication coming
afterwards.

Use the HSL Qualifier in Node 6 to pull a good strong skin tone key based on the
primary image. Given the way the node tree is now set up, that key is fed to Node 5,
and will limit whatever adjustments you make there.

nl & 7 B

Using Node 6 to pull a key from the image output by Node 1, and feeding that key to Node 5
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So now things are almost ready for an adjustment to be made to the actor’s skin tone,
however the same automatic setting that makes it easy to create Outside nodes is
inverting the key that Node 6 is feeding to Node 4, which is isolating everything except
for the skin tone. This is the opposite of what is needed.

Double-click Node 5 to select it, open the Key palette, and click the Key Input Invert
control so that Node 5’s key is identical to Node 6’s key.

Node Key

Key Input

Using the Key palette to control the key levels

Now, you can make your adjustment to Node 6’s grade, to lower the contrast, brighten,
and increase the saturation of the actor’s skin tone.

Inverting the key being input into Node 5, to make an adjustment to the actor’s skin tone

As a result of this operation, the background remains desaturated and contrasty, while the
actor’s skin tone has the brighter quality we need for the shot.
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Before/After Selective adjustment of skin tone

This example could have been handled in a variety of different ways, but the point is that you
can add nodes that connect to the state of the image at any part of a node tree, and use them
to generate keys to feed to any other node, regardless of what’'s happening to the picture

in between.

There’s another way you can manipulate a key from one node using another in the Node Editor,
and that’s to connect the KEY output from one node to the RGB input of another node. When
you do this, you can use any of the controls of the second node to manipulate the key, and you
can then use the result by connecting the RGB output of the second node to the KEY input of a
third node.

Connecting a KEY output to an RGB input to adjust a key with a second node’s controls

In the node tree shown above, Node 2 pulls a key, Node 3 manipulates the key, and Node 4
uses the key to make a color adjustment.

Keep in mind that a key is just a grayscale image. Setting up this kind of node structure lets you
use any of the second node’s controls, such as the Custom Curves, Noise Reduction or Motion
Blur controls, Sharpen, Midtone Contrast, Lift/Gamma/Gain, Contrast, or Log controls, to
manipulate the key in ways you couldn’t do using only the Matte Finesse controls.
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While this technique may not be necessary for conventional color isolations, it can come in very
handy when making tricky isolations with hard to key subjects, or when using one of the
Qualifier modes to pull a key to create transparency for compositing using the Node Editor’s
Alpha output. In this instance, you can connect the RGB output of a node used for key
manipulation directly to the Alpha output. In the example, Node 1 pulls a key, and the RGB is
connected to Node 2 which is used to color correct the foreground image. The KEY from Node
1is connected to the RGB of Node 3, which manipulates the key to clean it up prior to
connecting it to the Alpha Output block at the bottom right of the Node Editor.

Connecting a KEY output to an RGB input to adjust a key used to
create transparency via the Alpha output

Furthermore, this capability also lets you create keys in other ways besides using the Qualifier
palette controls. In the following example, the Contrast and Custom Curve controls in Node 3
create a high-contrast matte of the windows which is blurred. The RGB output of Node 3 is then
connected to the KEY input of Node 2, where the resulting key can be used for a variety of
adjustments; in this case, to tint the product within the image green. Alternately, this technique
could be also be used to create transparency via the Alpha Output.

Using a high contrast color correction as a key

Interconnecting KEY and RGB inputs and outputs is a powerful capability that lets you create
many kinds of workarounds for uncommon situations.

Chapter 30 — Working in the Node Editor

855



Using External Mattes

The External Matte node has evolved over the years. What was once purely a means for
importing matte channels for defining opacity and limiting adjustments has expanded to become
a way to import the RGB channels of a media file to be used for overlaying grain, texture, and
stylized distress onto an image, and even as a way to use the channels of a clip itself as a matte.

Matte clips are added to your project in the Media page. You can add them by attaching them
to a clip, so a particular matte is only available to a particular clip as part of a Clip Grade, or you
can add unattached mattes that stand alone in the Media Pool, which are then available to any
Track Grade. For more information about adding Matte clips in the Media page, see “Adding
and Removing External Mattes” in Chapter 8, “Adding and Organizing Media.”

Whether attached or unattached, mattes operate within a grade using EXT MATTE (external
matte) nodes. EXT MATTE nodes have the following outputs:

An external matte connected to the first node of a grade

. Four blue triangular key outputs let you output the channels
contained within the EXT MATTE node, but which channels are available affects what
is output. If the EXT MATTE node’s source clip has RGBA channels, then these are
available as Alpha, Red, Green, and Blue key outputs that you can attach to any other
node’s key input. On the other hand, if the EXT MATTE node’s source clip only has RGB
channels, then the key outputs that are made available are Y (luma), Red, Green, and
Blue, and a “Use Lum for Alpha Output” setting in the Node Editor contextual menu lets
you use the Y channel as a matte.

An interesting aspect of these four outputs is that each one is dedicated to individual A,
R, G, and B color channels. Ordinarily, External Matte clips are written with matte data
written simultaneously to all three RGB channels. However, you could also render
separate pure primary-colored mattes to each color channel (a so-called “disco” matte),
so that the Red channel has one matte, the Green channel another, and the Blue
channels still another, thereby exporting three separate mattes within a single media
file, for convenience. If you add another matte to the Alpha channel, you can even
export four mattes within a single file. You can then use each one of these mattes
individually by connecting the correct output of the Ext Matte node.

NOTE: For backward compatibility, projects from versions of DaVinci Resolve
previous to 12.5 continue to output RGBY from the triangular
outputs, not YRGB.
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. A round orange RGB output lets you connect the RGB image data of a
matte clip to any other clip’s RGB input. This is especially useful when you're combining
a matte clip with the current clip using a Layer Mixer node, to create a textured
composite of some kind.

Going back to the External Matte node’s original use, mattes are typically grayscale media files
that represent image opacity, and are meant to be used either as alpha channels for creating
opacity within a corresponding RGB clip, or as a matte for limiting effects.

An example of a matte channel would be the key created by a green screen keyer. If you output
just the key, that would be an external matte. If you receive an external matte along with an
effects clip, you can attach the matte to its corresponding RGB clip in the Media page. Then,
you can access that matte via an External Matte node in the Node Editor, so you can use the
key it outputs to limit different kinds of corrections you want to apply.

In the following example, the keyed matte of a green screen composite clip is used to apply
different corrections to the inside and outside of a keyed composite, in order to make the
subject match the background more convincingly.

Makeup_Green.mov

A matte attached to clip Makeup_composite.mov,
as seen in the Media Pool

To use an attached matte to limit an adjustment within a Clip Grade:
Right-click any node, and choose the attached matte you want to use from the Add
Matte submenu of the contextual menu.

By default, the EXT MATTE node that appears has its first output connected to the
Connect one of the EXT MATTE node’s triangular key outputs to the key input of a
node you want it to limit.

Select the node to which the EXT MATTE node is attached, and add an Outside node
to make it possible to add adjustments on either side of the matte.

Node Editor displaying the influence of the external matte on
multiple nodes when the keys are linked
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If necessary, select Node 1, and use the Key palette controls to modify the incoming
key, inverting or blurring it as necessary to create the isolation you need.

NOTE: Don’t select the EXT MATTE node, because it exposes different
controls in the Key palette for transforming, flipping, looping, and freezing
the matte.

At this point, you can add adjustments to the inside and the outside of this composited
shot to improve the composite.

Before/After: An external matte is used to apply separate grades to the
foreground and background of a previously composited clip

Ideally, external mattes are exported so that they match the size and duration of the RGB clip
they’re supposed to accompany. If they don’t match or if you're using some other grayscale clip
as an external matte to create some sort of effect, then there are parameters in the Key palette
that you can use to retime or transform a matte so it works better in your grade.

To slip the sync of a matte relative to the clip it’s attached to:
Select the Ext Matte node you want to slip.
Open the Key palette, and raise or lower the Offset parameter until the matte is
perfectly aligned with the clip it's supposed to match.

To transform a matte:

Select the Ext Matte you want to transform.
Open the Key palette, and turn off the Lock Matte checkbox.

Use the Pan, Tilt, Zoom, Rotate, Width, Height, HFlip, or VFlip parameters to adjust the
matte so it has the correct geometry.

It's worth mentioning that you can attach as many external mattes to a single clip in DaVinci
Resolve as you like. For example, if a CGl shot has been delivered with a set of isolation mattes
for each of three characters in the scene, you can import all three mattes and use them to
isolate adjustments that you want to make in the Node Editor.
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OpenEXR media is capable of containing multiple layers and multiple alpha channels, which can
also be accessed from EXT MATTE nodes. As a result, Resolve uses a slightly different but
related procedure for accessing these mattes.

To extract OpenEXR layers as external matte nodes:
Right-click any node, and choose the .exr clip name from the Add Matte submenu of
the contextual menu.

By default, the EXT MATTE node that appears has its first output connected to the
Connect one of the EXT MATTE node’s triangular key outputs to the key input of a
node you want it to limit.

Double-click the EXT MATTE node to select it, then right-click it and choose which
layer you want to use from the Select Matte submenu.

Select Matte

WHI_119_005_[0001-0001].exr, Layer 1 I
.

a\]

Right-clicking an OpenEXR file’s EXT MATTE node to choose which layer to use

OpenEXR files with multiple RGBA layers (or passes) embedded within them (RGBA +
RGBA + RGBA etcetera) or OpenEXR files with multiple alpha channels (RGBA + A + A)
expose multiple entries in this submenu. Whichever one you choose is the layer that
will be used as a matte by that EXT MATTE node.

Once you've extracted an OpenEXR layer, you can use it as you would any other EXT MATTE
node described in this section, to limit adjustments (as seen above), or to add texture or
transparency (as seen in the following sections).

You can also use external mattes as creative tools, to add grain and texture. For example, you
might use a more abstract animated matte, or a grayscale film scan of dirt and dust, to apply
correction for effect.
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Light leak and dirt and dust images From Warren Eagles’ Scratch
FX collection (FXPHD), designed to add texture to your grades

Once attached to a clip, external mattes can be exposed in the Node Editor, and their key
output can be used just like any other key in a node tree.

To use an attached matte to create texture a Clip or Track Grade:

When applying a matte as part of a Clip or Timeline grade, right-click any node

and choose the attached or unattached matte you want to use from the Add Matte
submenu of the contextual menu. Unattached mattes appear in the Add Matte > Track
Mattes submenu.

Disconnect the EXT MATTE node’s Key output connection to the Key input of the node
it's connected to by default.

Add a Layer Mixer to the end of the node tree.

Disconnect the bottom Corrector node’s RGB input, and then connect it to the EXT
MATTE node’s round RGB output.

A node tree set up to feed an EXT MATTE node’s RGB output to the input of a node
connected to a Layer Mixer, in order to blend it with the grade using composite modes
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Right-click the Layer Mixer node, and choose Overlay from the Composite Mode
submenu to blend the Ext Matte node most effectively with the grade.

If necessary, you can use the grading controls of the Corrector node to which you’ve
attached the EXT MATTE node to change the characteristics of the texture clip,
desaturating it for instance. You can also select the EXT MATTE node itself, open the
Key palette, and use the Transform, Offset, Loop, or Freeze controls described later to
change how the matte appears.

The resulting texture effect, blended with the grade using
the Overlay composite mode

If you want the texture you create to be unaffected by blur or sharpening
operations within the grade, be sure to add it to the very end of the node tree.

You can also use an EXT MATTE node to create transparency in a clip, for compositing with
clips underneath it on the Timeline.

To use an attached matte to create transparency in a clip:

Right-click any node, and choose the attached matte you want to use from the Add
Matte submenu of the contextual menu.

Adding an EXT MATTE node to a Clip Grade applies the effect to only that clip,
whereas adding an EXT MATTE node to a Track Grade applies the effect to the
entire Timeline.

Right-click any empty area of the Node Editor, and choose Add Alpha Output to reveal
the Node Tree output on the right that lets you assign a key to be used to define clip
transparency.

Connect one of the EXT MATTE node’s triangular key outputs to the Alpha output at
the right of the Node Editor.

The node setup for using an external matte to composite two layer
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The areas of the matte defined by the key are now rendered transparent.

The final composite created
using the external matte node

When you select an EXT MATTE node, the Key palette displays different parameters only for
mattes. Be aware that you must turn off the Lock Matte checkbox before you can make
adjustments to transform the matte.

External Matte

Transform

The Key Palette showing a texture layer added as an EXT MATTE node

- Standard Pan, Tilt, Zoom, Rotate, Width, and Height parameters let you
transform a matte to fit the image better.

. Two buttons let you flip the matte clip horizontally or vertically.

. Adjust this parameter to offset the start point of a matte clip.

. Turning on this checkbox freezes the matte clip on a single frame. Adjust the

Offset parameter to choose which frame to freeze on.

. Turning on this checkbox enables matte clips to loop endlessly, which lets
shorter matte clips cover longer durations.

. When turned on, locks the sizing of a matte to whatever changes are made
to the Input Sizing of that clip, so the matte transforms to follow the clip.

You can also use external mattes as creative tools. For example, you might use a more abstract
animated matte, or a grayscale film scan of dirt and dust, to apply correction for effect.
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Using the Key Mixer

The Key Mixer node lets you mix keys output from multiple Corrector nodes, combining them in
different ways to create a single key output. This makes it possible to build much more intricate
keys than you can with a single Qualifier or set of four Windows. In particular, the Key Mixer
node is the only way to combine multiple keys made using Qualifiers and Windows, adding,
subtracting, or intersecting them to create a highly specific result.

In the following example, you'll learn how to set up a Key Mixer to combine the keys output by
two Corrector nodes in a node tree. Then you'll learn how to change the way the input keys are
combined using the Key palette.

To combine two or more keys using the Key Mixer:

Right-click anywhere on the gray area of the Node Editor, and choose Add Node >
Key Mixer.

Create two Corrector nodes, then attach their RGB inputs to the RGB output from an
appropriate node in the main part of the tree, and attach their key outputs to the key
inputs of the Key Mixer.

Next, attach the key output of the Key Mixer node to the key input of the node you
want to use to make the correction. Remember, the objective is to use the key that’s
output by the Key Mixer to limit the adjustment being made using another node, in this
case Node 3.

Setting up the node tree you'll need to combine two keys together

Keep in mind, especially since this is a significant reordering of nodes in the Node
Editor, that every node needs to be connected properly for the overall grade to work.

Now that the node structure is fully connected, use Windows, Qualifiers, or both

to create keys in each of the nodes that you connected to the Key Mixer. In this
example, Node 2 is isolating the main skin tone, and Node 5 is isolating the blue of his
jeans and hood.

By default, all keys connected to the Key Mixer are added together, as you can see in
the Key Mixer’s thumbnail.
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Combining multiple keys with the Key Mixer

If you wanted, you can use the controls in the Key palette to change this, in order to
isolate the intersection of two keys, or to subtract one key from another. This is covered
in the next section.

Continuing with the previous setup where both keys are added together by default,
selecting Node 3 and dropping the saturation to be very faint stylizes the entire
background, while leaving the various hues of the man we’ve isolated alone.

Final grade, the talent in color with a B&W background

The way multiple keys are combined within the Key Mixer depends on a pair of Key Input
buttons you can toggle using the Key palette. In the following example, a partial green tint is
washed throughout the midtones of the image using a qualifier, but you want to exclude the
man’s skin tone from this operation. Using the Key Mixer, you can subtract one key from another
to accomplish this with ease.

A selective blue tint added to the midtones
of the image includes the red sign
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To change the Key Input settings for a node connected to a Key Mixer:

In this example, Node 2 is isolating part of the midtones of the image, and feeding
its key through the Key Mixer to Node 4, which is using it to apply a partial blue tint.
However, in preparation for subtracting the skin tone from this operation, Node 3 is
isolating the man’s skin tone.

A node setup in preparation of subtracting the Bar sign from
the midtone isolation being used to add a partial blue tint

To reveal the controls you'll use to change how the key from Node 3 interacts with the
key from Node 2, double-click the Key Mixer node to select it.

Open the Key palette; a list of all input links that are connected to the Key Mixer
appears at the right.

Key Mixer
Input Link 1

1.000

Input Link 2

1.000

Qutput Link

1.000

The Input List of the Key Mixer node

Within each list entry is the input name (Input Link 1, Input Link 2, etc.), a Matte control, a
Mask control, a gain parameter, and an offset parameter.

. Turn on both the Key Input Matte
button and the Key Input Invert button for Input Link 2
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Key Mixer

Input Link 1

1.000

Input Link 2

1.000

Qutput Link

1,000

Turning on Matte and Invert for Input Link 2
to Output Node 3 subtracted from Node 2

Turn on both the Key Input Matte
button and the Key Input Invert button for Input Link 1.

Key Mixer
Input Link 1

1.000

Input Link 2

1.000

Output Link

1,000

Turning on Matte and Invert for Input Link 1to
Output Node 2 subtracted from Node 3

Turn on the Key Input Matte
button for either Input Link 1 or Input Link 2.

Key Mixer
Input Link 1

1.000

Input Link 2

1.000

Output Link

1.000

Turning on Matte for Input Link 1to
output the intersection of two mattes

Turn on the Output Link Invert button.
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When you're finished, if you choose to subtract Node 3’s key from that of Node 2, the result
should resemble the following screenshot.

The result of subtracting a key of the man’s face from a key
of the overall midtones of the image, and using that to add
a selective green tint

New Key Mixer nodes have two key inputs by default. If necessary, additional inputs can be
added in order to combine even more keys with one another.

To add inputs to the Key Mixer:
= Right-click a Key Mixer node, and choose Add One Input.

When combining three or more keys, the interaction of keys using the Key palette controls
becomes even more complex, but the rules outlined above still apply.

Using the Key Palette

The Key palette contains parameters and controls that you can use to modify key channel data
being fed into or routed out of the currently selected node.

For example, the Key Input Invert control is always enabled, which is why the Outside node
works automatically. Clicking this control results in keys that are fed into that node exactly
mirroring the original key.

The controls that are available in the Key palette vary depending on what kind of node you
have selected:

- Have three sets of parameters. Key Input parameters let you make
adjustments to keys being fed through a node’s Key Input connection. Qualifier
parameters let you make adjustments to the internal key created with the HSL Qualifier
or Window controls. Finally, the Key Output parameters let you make adjustments to the
key data being output by a node’s Key Output connection, and includes the incredibly
powerful Offset Gain parameter that governs the strength of that node’s contribution to
the overall grade. This functionality is covered more extensively in the next section.
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. Have two sets of parameters. Transform parameters let you make
geometric transformations to a matte so it fits the clip it’s being applied to better. An
Offset control lets you slip the sync between an external matte and the clip to which it’s
applied. This functionality is covered in the section on External Mattes.

. Have two sets of parameters that are dependent on which of the
connections attached to a Key Mixer’s key inputs is selected. Input parameters let you
adjust how much of a contribution a key makes to the total key mix, and whether the
contribution is additive or subtractive.

The Output parameters let you adjust the inversion and strength of the key that’s output by the
Key Mixer. This functionality is described more extensively in the Key Mixer section.

Layer Mixer and Parallel Mixer nodes have no adjustable controls in the Key palette.

When you open the Key palette for a selected Corrector node, you can adjust the following
parameters:

Node Key

Key Input

Key Output

1.000

Qualifier

Key palette showing controls when a Node is selected

Key Input Controls

. Inverts the key being fed into the key input. This control is on by default,
which is why Outside nodes work to automatically adjust everything outside of the
secondary operation taking place in the node before.

. Lets you switch the key input between Matte and Mask modes. In Matte
mode (on by default) the key input combines via intersection with keys generated
internally using the Qualifier or Windows palette. In Mask mode, the key input is added
to the internal key instead.

- Controls the strength of the key connected to the key input.

- Controls the contrast of the key connected to the key input.

- Blurs the key connected to the key input

. Alters the horizontal/vertical ratio of the blur that’s being applied to the
key input.
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Key Output Controls

. Inverts the overall key.

. Using the key output, this parameter governs the strength of that node’s
contribution to the overall grade. Setting Gain to O results in that node having no effect
at all, while the default setting of 1.00 applies the full strength of any adjustments made
with that node. The maximum setting of 2.00 increases the intensity of any part of the key
output that’s less than 100 percent white. You can also use this parameter to keyframe
the key output to fade that node’s contribution in or out with one set of keyframes.

. Lets you adjust the contrast of the Output key. This has no effect if the entire
key is 100 percent white (a solid key).

Qualifier Controls
. Inverts the key created by that node’s Qualifier palette.

. Lets you switch the interaction of the keys generated by the Qualifier
and Window palettes between Matte and Mask modes. In Matte mode (the default), the
Qualifier and Windows palettes combine via intersection. In Mask mode, they’re added
together instead.

. Lets you raise or lower the strength of the key generated by the Qualifier palette.

. Lets you adjust the contrast of the key generated by the Qualifier palette.

When you open the Key palette for a selected Key Mixer node, you can adjust the
following controls:

Key Mixer

Input Link 1

1.000

Input Link 2

1.000

Qutput Link

1.000

Key palette showing controls when a Key Mixer is selected

- A list of every input that’s connected to the Key Mixer. Each entry on the list
has the following controls:

- The name of each node connection attached to that key mixer, such as
Input Link 1, Input Link 2, etcetera.

. Inverts the key being fed into this particular input. Off by default.

. Lets you switch the key input between Matte and Mask modes. In Matte

mode (on) the key input combines via intersection with other inputs connected to the
Key mixer. In Mask mode (off by default), the key input is added to the other key inputs
connected to the Key mixer.

- Decreases or increases the intensity of that input matte’s contribution
to the resulting output matte.
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. Adjusts the contrast of that input matte’s contribution to the resulting
output matte.

. Inverts the overall result of the various Input Link interactions.

- This parameter increases or reduces the strength of the resulting output key.
Setting Gain to O results in all inputs being set to black, while the default setting of 1.00
outputs the combined mattes at full strength. The maximum setting of 2.00 increases the
intensity of any part of the key output that’s less than 100 percent white, which can have
the practical effect of “growing” soft edges. You can also use this parameter to keyframe
the key output to fade that node’s contribution in or out with one set of keyframes.

. Lets you adjust the contrast of the Output key.

Several of the techniques discussed in here and in “Secondary Qualifiers,” can be further
customized using the Key Output Gain parameter, which makes it easy to control the strength of
a node’s effect on your grade with a single adjustment. In the following example, two simple
Serial nodes are applied to a clip, with the first one expanding image contrast, and the second
one using a variety of controls to add some extreme warmth to the highlights.

A tint applied only to the highlights of the image

If you decided that you want to reduce the amount of warmth added by the second node
without readjusting the controls you used to create the effect, you could open the Key palette
and lower the Key Output Gain parameter to fade the effect with a single adjustment.

Four versions of this grade shown using the Versions option of the Split Screen
controls, with Output Gain setto 1, .75, .5, and.25 for comparison
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This principle also works for controlling the strength of individual nodes that are being
combined in parallel, that are combined using the Layer node, or for simply fading out the effect
of any node in the node tree you want to “turn down” a bit.

Isolating, Splitting, and
Converting Color Channels

DaVinci Resolve provides two different methods of making channel-specific adjustments,
depending on whether you need to apply an adjustment to just one channel within a single
node, or apply separate adjustments to all three channels across several nodes.

Within the contextual menu of each node in the Node editor is a series of four options:

Disabling channels and switching color spaces

= A Color Space submenu that lets you change the color space that node works
in between RGB (the default red/green/blue), YUV (actually Y’/Cb/Cr), HSL (Hue/
Saturation/Lightness), and LAB (Luminosity/A/B).

= Three checked Enable Channel 1-3 options let you turn individual channels off or on,
limiting which channels operations within that node will affect.

In combination, these controls let you choose a color space for a node to work within, and then
choose which channels of that color space you want to affect with that node’s adjustments. In
the following example, you'll see how to use these features to selectively sharpen just the Y’
(luma) of an image without affecting the chroma, which can be a more subtle effect than simply
sharpening the entire image.
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To use channel disabling and color space conversion to sharpen luma only:

Add a node with which to apply the sharpening you want to the current clip.

Right-click the new node, and choose YUV from the Color Space submenu of the
contextual menu.

Apply sharpening by doing one of the following:

= Using that node’s contextual menu, uncheck Enable Channel 2 and Enable Channel
3, which correspond to the U (Cb) and V (Cr) channels, leaving only Channel 2 (Y)
enabled. Then, open the Blur palette, and drag the ganged Radius sliders down to
sharpen the Y channel.

= You can also just open the Blur palette, ungang the Radius sliders, and drag the
red slider down to sharpen the Y channel, since any control with three gangable
sliders will automatically assign those sliders to whichever channels are used by the
currently selected Color Space.

The original image

Sharpening applied to only the Y’ channel of the image

As you can see, while the Blur palette ordinarily provides separate R, G, and B controls that can
be unganged from one another, the Color Space submenu lets you apply sharpening to the
channel definitions of other colorspaces, providing many other corrective and creative
possibilities with the same controls.
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Supported Color Spaces for Conversion

The Colorspace submenu available when you right-click a node in the Node Editor
supports four different color spaces that you can set each node to work within. When
you choose a color space other than RGB, all channel-specific controls (the Custom
curves, Soft curves, RGB Lift/Gamma/Gain sliders, and RGB mixer) operate on the
particular channels of that color space, rather than the default YRGB channels. By
switching color spaces, you can achieve very different kinds of adjustments by
swinging values among mathematically different axes.

YUV converts the image into Y’, Cb, and Cr channels. The Y’ channel governs
luminance, while the Cb and Cr are color difference channels that work within the
broadcast model of color.

HSL converts the image into Hue, Saturation, and Lightness channels. Lightness is
identical to Luminance, while Hue and Saturation are exactly as described.

LAB operates on the L, A, and B channels. The L channel governs luminance, while the
A and B channels are color difference channels; A adjusts color on an axis from
magenta to green, B adjusts color on an axis from yellow to blue.

Another method of applying corrections to individual color channels is using the Splitter/
Combiner nodes, which break the Red, Green, and Blue channels apart into separate node
tree branches, each capable of accepting multiple serial and parallel nodes of image
adjustment. There are two ways you can create a Splitter/Combiner node structure.

Methods of adding Splitter/Combiner nodes:

= To add a pre-made Splitter/Combiner node structure: Choose Nodes > Add Splitter/
Combiner Nodes (Option-Y). A Splitter and Combiner node appear already connected
to three Corrector nodes, one for each color channel.

= To manually construct a Splitter/Combiner node structure: Right-click in any empty area
of the Node Editor, and choose from the Add Node submenu to create a Splitter node,
a Combiner node, and three Corrector nodes, wiring them together as necessary to
create the desired effect.

The Splitter Combiner node structure

Chapter 30 — Working in the Node Editor

873



The Splitter node takes an incoming image and provides individual outputs for each color
channel (top/red, middle/green, bottom/blue). When you connect each of these output to a
Corrector node, that color channel automatically connects to all three internal channels of that
node, so that the default three nodes in a Splitter/Combiner structure are internally processing
red/red/red, green/green/green, blue/blue/blue. The Combiner then pulls the Red, Green, and
Blue channels out of each node connected to its three inputs, and reassembles them into a
single RGB image again. Of course, what happens in between the Splitter and Combiner is
entirely up to you.

One of the simplest ways of showing the possibilities of this node structure is to combine it with
Node Sizing in the Sizing palette. Using Node Sizing, you can correct for misaligned channels in
older archived video, or create channel misalignments for creative looks. In the following
example, a simple Node Sizing adjustment to a split Blue channel will create an interesting
“prism vignette” effect.

To use Node Sizing on individually split channels:
Choose Nodes > Add Splitter/Combiner Node (or press Option-Y) to add a pre-made
Splitter/Combiner node structure to the Node Editor.

Select the middle of the three Corrector nodes appearing in between the Splitter and
Combiner nodes (Node 5 in the following screenshot).

Open the Sizing palette, choose Node Sizing from the Mode pop-up, and then raise the
zoom parameter by a small amount; this example uses 1.014.

Zooming just one color channel
using the Splitter/Combiner nodes

As you can see in the screenshot, just the Green channel has been zoomed in on
across the entire image. This is only possible using Node Sizing. This is cool, but not
quite what you need.

Open the Window palette, add a Circular window, turn on its Invert control, and
transform it to be a very soft, horizontally aligned vignette. This limits the individual
scaling done to the Green channel to just the outer edge of the image, similar to a lens
with excessive chromatic aberration.

The resulting channel split effect
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You could easily keep going, applying varying amounts of zoom with different window shapes
to each of the other color channels, and perhaps adding some blur to enhance the effect, but
this example should show the creative potential available when using this technique.

Putting Nodes into HDR Mode

When using various grading controls in the Color page to grade wide-latitude images for HDR
output, you may find it useful to enable the HDR Mode of the node you're working on by
right-clicking that node in the Node Editor and choosing HDR mode from the contextual menu.

+ HDR Mode [-_._a

Using a node’s contextual menu to
put that node into HDR mode

This setting adapts that node’s controls to work within an expanded HDR range. Practically
speaking, this makes it easier to work with wide-latitude signals using controls that operate by
letting you make adjustments at different tonal ranges such as Lift/Gamma/Gain, Custom
Curves, Soft Clip, etcetera.

Compositing Using the Alpha Output

While DaVinci Resolve can use the alpha channel of imported media for compositing, the Alpha
output in the Node Editor is an optional output that you can turn on to create clip transparency using
operations inside DaVinci Resolve to create composites against other clips on lower video tracks.
There are many ways of using the Alpha output, but this section will focus on three examples.

In this first example, the Alpha output will be used to composite a green screen clip with a
background plate.

A green screen clip, ready for compositing
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In preparation for this composite, the background plate is on track V1 of the Timeline, and the
green screen clip has been superimposed on track V2.

A superimposed green screen clip on track V2 of the Timeline,
above a background plate on track V1, ready for compositing.

To create a chroma-key composite in the Color page:

Right-click anywhere within the gray area of the Node Editor and choose Add Alpha
Output to add the Alpha output at the left of the node graph.

An Alpha output appears underneath the Node Tree output at the right of the Node Editor.

The image Node Tree output
with Alpha output below

You'll want to use Node 1to color correct the image to optimize it for keying. In this
example, the foreground plate is log-encoded, so a LUT is added to Node 1to normalize it.

Add a Serial node after Node 1and connect its key output to the Alpha output. This is a
fast way to build this composite if you're confident that the corrections you’ve made in
Node 1won’t adversely affect the key (or if you know they’ll improve it by expanding the
contrast of a flat-contrast source clip).

Alternately, you could create a second processing branch by adding a disconnected
node (Node 2), connecting the Source node to its RGB input, and then connecting its
key output to the Alpha output you just added. Creating a second image processing
branch from which to pull your key lets you key directly from the source (assuming the
source is fit to key without adjustment), avoiding any problems that grading the first
node could introduce to the key.
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Node 1 grades the clip, expanding contrast to improve both the image,
and its ability to be keyed. Node 2 uses Qualifier controls to pull the key.

Use the Qualifier controls of Node 2 to key out the green background, and then turn on
the Invert checkbox to create the proper composite. In this example, we're using the 3D
Quialifier mode to pull a high-quality key.

Qualifier

Selaction Range

r.4
VA
. 133 184 Matte Finesse
0.0
1000
15.2
1.9

0.0

0.0

An HSL Qualification to key the green feeding
the Alpha Output to create transparency

If there’s green spill in the composite (or blue in cases where you're keying a
bluescreen) you can turn on the Despill checkbox to eliminate it.

You can also use a Power Window to garbage matte out any elements you don’t want
intruding into the shot, using the Tracker palette if necessary to make the window
follow the motion of the foreground subject.
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A Power Curve used to garbage matte
out unkeyable lighting fixtures

If necessary, you can add another node to the output of Node 2 to make whatever
corrections are necessary to the background plate clip to make the composite blend
more seamlessly. For example, with this additional node selected, you could right-click
the background clip and choose “Shot Match to This Clip” to use the automatic shot
matching in Resolve to adjust the foreground to match the background.

Adding more color adjustments to a node added after the Qualifier

With all this set up, you end up with a nice green screen composite that’s visible in both
the Color and Edit pages.

The result, with a window garbage matte cropping
out the equipment, ready for further refinement

If you’ve been provided with a separate Matte clip for defining clip transparency, you can use
that Matte clip within the node tree of a superimposed clip to create a composite using the
Alpha Output.
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To create a composite using an external matte:

To associate an external matte with a clip, open the Media page, select the clip you
want to add a matte to in the Media Pool, navigate to the matte file using the Library
browser, and then right-click the matte file and choose Add as Matte. For more
information on importing mattes, see Chapter 8, “Adding and Organizing Media.”

Open the Color page and select the foreground clip in the Thumbnail timeline, then
right-click Node 1in the Node Editor and choose the matte you added from the Add
Matte submenu.

An EXT MATTE node appears underneath Node 1, with the first of its four key outputs
connected to Node 1's key input. (Working with external mattes is covered in more
detail in a prior section of this chapter.)

Now, right-click anywhere within the node graph (other than on a node) and choose
Add Alpha Output from the contextual menu.

An Alpha output appears underneath the Node Tree output.

Drag a connection line from the second key output of the EXT MATTE node to the
Alpha output.

Using an external matte in the grade and to the Alpha output

You should now see a successful composite, with the external matte creating a region of
transparency in the foreground clip though which the background clip shows through.

Before and after the final composite, created by connecting an
Ext Matte node to the Alpha Output in the node graph
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If you've installed an OFX plugin capable of keying, you can right-click the node you’ve applied
it to and choose Use OFX Alpha to route the key created by the plug-in out the KEY output of
that node. When Use OFX Alpha is enabled, the HSL Qualifier and Window palette output is
ignored, the only key that’s output is from the OFX plug-in.

Use OFX Alpha

Choosing Use OFX Alpha in the Node Editor

Once Use OFX Alpha is enabled, and you've created a key using your OFX plug-in of choice,
you can right-click anywhere within the node graph (other than on a node) and choose Add
Alpha Output from the contextual menu to make the Alpha output appear, and you can then
connect the KEY output from the node with the OFX plugin to the Alpha output to use it to
create transparency.

Setting up a composite using an OFX plugin

NOTE: When Use OFX Alpha is enabled for a node, you cannot use a window
to create a garbage matte within that node as you would when keying with the
HSL Qualifier. To create a garbage matte with which to exclude unwanted and
unkeyable elements from the edges of the picture, you'll need to combine the
key from a window in another node with the key output by the OFX plugin
using a Layer Mixer node
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Combining an OFX key with a Window using a Key Mixer to add a Garbage matte

Compositing Entirely Within an OFX Plug-In

Certain OFX plug-ins that are capable of combining two image streams to create a composite
can be used as of Resolve version 11.1 by exposing a “second layer input” on the node to which
that plug-in has been applied. This makes it possible to composite the image you're grading
with the RGB output from an EXT MATTE node.

Combining a clip with an EXT MATTE image using the second
layer input of a node with an OFX plug-in applied to it

To create a composite using an OFX plug-in:

Open the OpenFX Panel, use the Library to find the OFX compositing plug-in that you
want to use, and drag it onto the appropriate node to apply it. The above example
shows the Boris Effects plug-in “BCC Composite,” which mathematically combines two
image streams using one of a long list of blending modes.

Right-click the node with the OpenFX plug-in applied to it, and choose Second Layer
Input from the contextual menu. A second RGB input should appear on the left of the
node, underneath the first.
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Add OFX Input [

Adding the second layer input of a node
with an OFX plug-in applied to it

Open the Media page, locate the clip you want to composite in the Library, and import it
as an unassigned matte.

Open the Color page again, right-click the node with the OpenFX plug-in applied to it,
and choose Add Matte > Track Mattes > “name of matte imported in step 3” from the
contextual menu.

By default, the EXT MATTE node that appears is connected via one of its key outputs.
Delete the key connection, and drag a new connection line from the EXT MATTE
node’s RGB output to the second RGB input of the node with the OpenFX plug-in.

The composited image, node tree, and OFX parameters shown side by side

At this point, the node tree is wired up to composite the clip with the EXT MATTE
image, and you need only adjust the parameters of the OpenFX plug-in to achieve the
result you desire.
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